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Using the Database Binding Component

The Database BC provides a comprehensive solution for configuring and connecting to
databases that support JDBC from within a JBI environment. In this tutorial, you will create a
SOA project using BPEL and the Database Binding Component, create a Composite
Application, and then deploy and test the application.

The topics listed here provides information about Understanding the Database Binding
Component (BC).

What You Need to Know

These topics provide information you need to know before using the Database Binding
Component.

= “Tutorial Plan” on page 6.
= “Database Binding Component Project in a Nutshell” on page 7.

What You Need to Do

These topics provide instructions to complete a Database Binding Component sample Project.
It also helps to test the Binding Component on the system and demonstrate how it is
implemented.

“To Start the GlassFish V2 Application Server From NetBeans IDE” on page 10.
“To Create a BPEL Module Project” on page 12.

“To Connect to a MySQL Database” on page 14.

“To Start the Admin Console” on page 18.

“To Integrate a JDBC Driver” on page 20.

“To Create a JDBC Connection Pool” on page 20.

“To Create a JDBC Resource” on page 23.

“To Create a WSDL Document : dbWSDL” on page 25.
“To Select the Database Connection” on page 27.

“To Edit the SQL Code” on page 30.

“To Create a WSDL Document : SOAPWSDL” on page 34.



Tutorial Plan

“To Create a BPEL Process” on page 42.

“To Add a Partner Link” on page 44.

“To Add a Web Service and Basic Activities” on page 45.
“To Edit Web Service : Receivel” on page 49.

“To Edit the Web Service : Invokel” on page 51.

“To Edit the Web Service : Replyl” on page 55.

“To Edit the Basic Activities : Assignl” on page 57.

“To Edit the Basic Activities : Assign2” on page 59.

“To Invoke Explicit Validation” on page 61.

“To Create the Composite Application Project” on page 64.
“To Deploy the Composite Application” on page 72.
“To Test the Composite Application” on page 74.

“To Debug the Test Case” on page 79.

Tutorial Plan

Below is a summary of the steps that this tutorial takes you through to create a Composite
Application using the Database BC.

A

o »® NS

Create a BPEL Module project using the New Project wizard.

Create Database BC and SOAP BC WSDL documents for the BPEL Module.

Create a Composite Application project.

Add the BPEL Module project (*.jar) as a JBI Module to the Composite Application project.

Build the Composite Application project and make sure that the Application Server is
started.

Deploy the Composite Application project to the Application Server.
Create Test Case.

Run the Test Case.

(Optional) Debug the BPEL process.

This is performed when the Test Case fails.
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Database Binding Component Project in a Nutshell

START

Create a BPEL Module
project

v

Create a Composite
Application project

v

Add the BPEL Module as a
JBI Module

v

Build the Composite
Application project

v

Make sure to start the
Application Server or
GlassFish V2

v

Deploy the
Composite Application project
to the Application Server

v

Create Test Case

v

Run Test Case

=D -

Database Binding Component Project in a Nutshell

Debug the
BPEL project

The illustration explains the entire process.

Flowchart 1
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Database Binding Component Projectin a Nutshell

BPEL Module

Click New Project -> SOA ->

v

1. Click Projects tab

2. Right-click Process Files -> New ->
WSDL Document or Right-click
BpelModule -> WSDL Document

v

Choose Concrete WSDL Document

v

v

Select Binding

Type;
DATABASE

Select Binding

Type;
SOAP

v v

1. Click Service tab
2. Check for Database Connectivity

Select any one of the
following

Binding Subtypes:

« Tables

» Prepared Statements
* Procedures

» SQL File

v

Select any one

of the following
Binding Subtypes:
* RPC Literal

» Document Literal
* RPC Encoded

v

Select Input and
Output Abstract
Configuration

v

1. From the Right-hand panel, click
SOAPWSDL.wsdl editor tab or from the
Left-hand panel, double-click
SOAPWSDL.wsdl and click Bindings

2. Right-click and check the properties of input

(literal) and output (literal)
Bindings of the created WSDL

3. Save the Project

Flowchart 1 (Continued)
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Database Binding Component Project in a Nutshell

?

Right-click Process Files -> New ->
BPEL Process

v

1. Drag and Drop the Input WSDL
(SOAPWSDL.wsdl) to the left of the
BPEL panel and Output WSDL
(dbWSDL.wsdl) to the right of
the BPEL panel

2. Click Palette. Select the following:

a. Web Service - Receive:

Basic Activities - Assign

b. Web Service - Invoke
Basic Activities - Assign

c. Web Service - Reply

3. Edit each Web Service and Save All

v

1. Double-click the Process Mapper -
Receive. This displays the Mapper
tab.

. Expand the Input and Output
variables

. Map the Input and Output variables

. Save the Project

N

AW

v

—_

. Double-click Process Mapper -

N

. Expand the Input and Output
variables

. Map the Input and Output variables

. Save the Project

H W

Invoke. This displays the Mapper tab.

v

—_

. Double-click Process Mapper -
Reply. This displays the Mapper tab.

. Expand the Input and Output
variables

. Map the Input and Output variables

. Save the Project

N

» W

the project

. | Start GlassFish V2 Server
" |anytime before deplying

1. Expand Composit Appl -> Test ->
New TestCase1

2. Select BpelModule -> Process Files

a. SOAPWSDL.wsdl

b. SOAPWSDLPort
(Binding="SOAPWSDLBinding”) ->
SOAPWSDLOperation

3. Click Input.xml tab -> delete existing
value and enter a new value
(For example: 1)

4. Save the Project

5. Right-click TestCase1 -> Run

T

Right-click Composit Appl -> Deploy

T

Configure the Pool in Admin console

T

1. Click Projects tab

2. New Project -> SOA -> Composite
Appl -> Right-click -> Add JBI
Module -> Select BPEL Module
-> Add Project JAR Files

3. Composit Appl -> Right-click Clean
and Build

4. Save the Project

T

Right-click and Build the BpelModule

f
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Starting the GlassFish V2 Application Server

Starting the GlassFish V2 Application Server

Follow the procedure to start the GlassFish V2 Application Server.

v To Start the GlassFish V2 Application Server From

NetBeans IDE

1 Choose Window —> Services, if the Services tab is not visible.

2 Click Services tab and expand the Servers node.

The Servers node should contain a GlassFish V2 subnode.

3 Right-click the GlassFish V2 node and select Start.

{J NetBeans IDE 6.1

BEX]

PEES XTSEDE TH

‘Projects ‘Files ‘Services 41 x| |
# B Datahases
+-0 web Services

i @ Enterprise Beans (2,x)

[= EE SErvers
& a2
Navigator | Start %le.jug Mode 40 x|

Start in Profile Mode

Refresh

Remove

Yiew Admin Console
View Server Log
Wiew Update Cenber

Propertiss —

File Edk iew Mavigate Source Refactor Bulld Run Profile  Yersioning

Tools ‘Window Help

I =
{5

The Output window displays logging information about the application startup.
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Creating a BPEL Module Project For Table Type Operations

The following message appears in the Output console indicating the application server is
listening.

Application server startup complete

Note - A green arrow badge on the GlassFish Application Server node indicates the server is
listening.

File Edt Yiew Mavigate Sowrce Refactor Build RBun  Profile Versioning Took  Window ﬁah

‘Projects ‘Files ‘Services Al x|
.'."' B Dstabases
+ @, ‘Web Services
+ @ Erterprise Baans (2.x)
=5 servers
=%, y PassFish V2
# (3 Applications
+-19 Resources

S mmas
w0y |t
- Dubpat ¥ o=
¥ | Jaya DB Database Process x GlassFish V2 x| :
b |WEBO20Z: Starting Sun-Java-System/Application-Server. ~

WEED7L1lZ: Starting Sun-Java-Systew/Application-Server HTTF/Ll.l on 8020
;'[l!'EBG‘.'-'lZT Starting Sun-Java-Systen/Application-Server HITPSl.l on 2121
] é'[l]'EBEI'.-‘lZ: Starting Sun-Java-Systen/Application=Server HTTP/Ll.l on 4848
| sMGTODD7: Self Managenent Rules service is enabled
2 fj.ppliumnn sertver startup Eﬂpllt.l_l w |

|2 T L

Creating a BPEL Module Project For Table Type Operations

A table represents a database table. It consists of fields and methods. This allows you to perform
query, update, insert, and delete SQL operations in a table.

= Fields correspond to the columns of a table
= Methods are the operations that you can apply

Using the Database Binding Component 1



Creating a BPEL Module Project For Table Type Operations

Create a BPEL Module project with a name BpelModuleSample.

v To Create a BPEL Module Project

1 Choose File —> New Project from the main menu.

This opens the New Project wizard.
2 Selectthe SOA node from the Categories list.

3 Select the BPEL Module node from the Projects list.

Qe

Steps Choose Project
1. cChoose Project Cateqories: Frojacts:
2 . ) Java . Composite Application
) web '_E_ BPEL Madule
) Enkerprise } ¥SLT Modde
23 NetBeans Moded |5 DtaMashup Moduie
O S0A
i Samples
[l (3]
Descripkion:

.Craates an empby BPEL Module, which may contain mudiple
BPEL processes,

(o)

4  Click Next.

5 Inthe Project Name field, enter BpelModuleSample.
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Creating a BPEL Module Project For Table Type Operations

6 Click Browse to navigate to the project location field.
The IDE stores the project files in this location. You can leave the default value.

Steps Name and Location

1. Choose Project ProjectName:  BpelMadkiesample]
2. Name and Location

Project Locstion:  [:|Database [ erowss... |
Praject Folder: D:\DatabaselBpaiModuleSample |

[] Set as Main Project

oo | ] )| o

7 Click Finish.

The Projects window now contains a project node for a BPEL Module project.

.-. ‘ Run Profile Versioning Tools Window Help
PEES XHEDE TEHIPB-@-

:Projects 4 x :Files | Services

-l Process Files
Referenced Resources

8 Click Save All.
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Connecting to a MySQL Database

Connecting to a MySQL Database

14

Connections to databases are managed using database drivers, which enable applications
written in different programming languages to interact with the database management system.
Java CAPS include the MySQL Native (mysql-connector-java-5.1.5-bin.jar), whichisa
Java implementation of the JDBC API, and communicates directly with the MySQL Driver.

To Connect to a MySQL Database

Click Services tab.

Expand the Drivers node from the Database Explorer. Right-click the MySQL (Connector/J
driver) and select Connect Using.

The New Database Connection dialog box is displayed.

'O NetBeans IDE 6.1 Mm%

File Edkt “iew Mavigate Source Refactor Build Run Profile Yersioning Tools Window Help

PSS 9 T IPR-@G-

: Projects :Files ‘Services Al x|
=& Datsbases
g JavaDB
=I-{J Drivers
| @® IDBC-ODBC Bridge
## Java DB (Embedded)
@2 JavaDB (Network)
@ MySQL (Connector/] driver)
@ PostgreSoL Connect Using
¥ Ef-_al jdbc:derby:f/locabhost: 1527 /sam  Delate %Dde{'ﬁ
¥ ,E_zj jdbc: derby: locathost: 1527 ftr s Customize '
¥ f_c;] jdbc:darbey: fflocakhost: 1527 fir [vir on VIR )
# @ Web Services
* @5 Enterprise Beans (2,x)
£ LQ Servers

£3 2]

In the Basic Setting tab, enter the Database's URL in the corresponding text field.

The URL identifies the type and location of a database server. The format is
jdbc:mysql://hostname:port/database_name.
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Connecting to a MySQL Database

4  Enter User Name and Password.

Note - Select the Remember password option. This is optional.

.
&

Basic setting l Advanced |

Mame: [MySOL (Connectaori] driver ) [ae]
Dirivet: | com.mysqgl.jdbc, Driver |
Database LRL: hdbc:mysql:,l’,l’::HOST:b: <PORT =/ <DEB = M
User Mame: | |
Password: | |

[] remember password
(see help for information on security risks)

(] 4 ][ Zancel ][ Help
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Connecting to a MySQL Database

5 Click OK to accept the credentials.

This displays a new Connection node in the Database Explorer under the Databases node.

-,

|| Basic setting | Advanced |

Select a database schema to use,

Seleck schema: | <o cchema s H Get Schemas

onnection established,

(] 4 ” Zancel ][ Help

6 Click OKto accept the default schema.
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Connecting to a MySQL Database

7

Right-click the MySQL Database URL in the Services window (Ctrl-5). Click Connect.

This opens the New Database Connection dialog box.

'O NetBeans IDE 6.1

BEx

File Edit Wiew Mavigate Source Refactor Build Run Profile Wersioning Tools Window Help

FEES XDEDE

TH ) B 6

: Projects ] Files [ Services 4l =

=& Databases
[i My30L Server at ieccapss.india,sun.comieccaps
[i Java DE

Eﬂ jdbc:derbey: [ flocalbost: 1527 fsample [app on APP]
Eﬁﬂ jdbc:derby: [ flocalbost: 1527 ftravel [kravel on TRE
Eﬂ jdbc:derbey: [flocalbost: 1527 fvir [vir on WIR]

. [E3| ke =8, india. sun.con

L{l.@. Web Services
i+ Enterprise Beans (2.x)

Discur-necm

IEI Servers

Execute Command. ..

Refresh

£ i

Delete Delete

Properties &
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Starting the GlassFish Admin Console

The illustration shows that the Database Connection is enabled.

'O NetBeans IDE 6.1 =X

1

FI|E E|:||I: 'I.I'IEW Nawgate Su:uuru:e ReFactu:ur BU|I|:| Run F‘ru:uFlIe '-.-'ersu:unlnu: Tu:u:uls '-.-'-.-'mu:lu::w Help

‘EEE“—*‘- Lb Eﬁ”ﬁ

':Pru]eEl:_s__ _;FI|ES Services 41 x|
f—i'----% Databases

’+' E:l jdbciderby: fflocalhost: 1527 sample [app on .ﬁ.F‘F‘]
'+----E:| jdbciderbey: fflocalhost: 1527 travel [travel on TR.ﬁ
.:E_.-l jdbe:derbey: fflocalhosk: 1527 fir [vir on YIR]
=} {El |j|:|I:n::mysql:,l',l'ieu:u:'apsﬂ.inu:lia.sn__ln.ccum:SSDEu,l'edl:ul:u:
[+~ Tables
I:'F_._l Views
I'El_i Procedures
'+'.@_ Web Services
|- Enterprise Beans (2.x)

n£ Servers

You are now connected to the MySQL RDBMS in the IDE.

Starting the GlassFish Admin Console

You define the database connections for your project using the GlassFish Admin Console.

v To Start the Admin Console

1 Openaweb browser and enter the following URL:
http://hostname:port/login.jsf

Note - The default port is 4848.

2 Enterthe User Name and Password.

18 Oracle Java CAPS Database Binding Component Tutorial « March 2011



Setting Up Database Access

Note - The default username is admin; the password was specified during installation.

3 ClickLogin.

Sun Java = System Application Server
Admin Console

Uzer Name:  admén

Passwond:

ELA L L Ll sl

Setting Up Database Access

Follow these steps to create and configure a database connection:

1. Make the driver's JAR file accessible to the domain's server instance. See “To Integrate a
JDBC Driver” on page 20.

2. Create a connection pool for the database. See “To Create a JDBC Connection Pool” on
page 20.

3. Create a JDBC resource that points to the connection pool. See “To Create a JDBC
Resource” on page 23.

Integrating a JDBC Driver

A JDBC driver translates an application's JDBC calls into the protocol of the database server.

Using the Database Binding Component 19



Setting Up Database Access

20

¥ ToIntegrate a JDBC Driver

1

Make the driver accessible to the common class loader.
a. Copythedriver'sJAR and ZIP files into the JavaCAPS_Home\appserver\lib.
b. Restartthe application server.

Make the driver accessible to the system class loader.

Creating a JDBC Connection Pool

When creating the pool with the Admin Console, you are actually defining the aspects of a
connection to a specific database. A JDBC connection pool is a group of reusable connections
for a particular database. Because creating each new physical connection is time consuming, the
server maintains a pool of available connections to increase performance. When an application
requests a connection, it obtains one from the pool. When an application closes a connection,
the connection is returned to the pool.

Before creating the pool, you must first install and integrate the JDBC driver. See “To Integrate
aJDBC Driver” on page 20.

When creating the Create Connection Pools, certain data specific to the JDBC driver and the
database vendor must be specified. Before proceeding, gather the following information:

m  Database vendor name
= Resource type (select one of the following options):
= javax.sql.DataSource (local transactions only)

= java.sql.ConnectionPoolDataSource (local transactions, possible performance
improvements)

= javax.sql.XADataSource (global transactions)
= Data source class name

= Required properties, such as the database name (URL), user name, and password

To Create a JDBC Connection Pool

Select the Common Tasks node, then click Resources —> JDBC —> Connection Pool.

Note - Select New to create a new connection pool from the New Connection Pool page.

Oracle Java CAPS Database Binding Component Tutorial « March 2011



Setting Up Database Access

2 Specify the General Settings as follows:
a. Name: Specify a Name for the pool.

b. Resource Type: Select a Resource Type from the drop-down menu.

See the list of choices above.

c. DatabaseVendor: Select a vendor from the list provided in the drop-down menu.

B e e e

| e ™ @t B o

R

ation Server Admin Console

O towmn Tagin Rsisgrs o DB > Consscisn Puol
[ Aawiaatin Sarvar New JOBC Connection Pool (Step 10f 2) m |
® i sopicrem bl M iyl il - F

! Wimt Sarw e

i - Garerw Setings
tiE = .
o ] e o
" g A Wbt TV e s Datsioe l
v oo dotr Lo el o .
h_ﬁ DB Ramcs o Datubae Vs o ooy M

B e Treten
B et
7] oo saiwalCs

- S e—

- '.: M Agpmacey
o] ol Rk TR
L
* gy Desssiors
= Covigum =
4

3 Click Next.

4 Specify the additional General Settings as follows:

= Datasource Classname: If the JDBC driver has a Datasource class for the resource type and
database vendor specified in the previous page, then the value of the Datasource Classname
field is provided. An example for MySQL is
com.mysql.jdbc.jdbc2.optional.MysqlDataSource.

= Description: A text description of the connection pool.
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Setting Up Database Access

- T Feaaarces » QHL - Consacmn Puolk
o —— New JOBC Connection Pool (Step 2 of 2) | Presmn || s |
- R Sy fos. puirnl siibingn o e
i e e
Eil = Caneral Satingy
* g e [Re——
- Cumke Blew Ssmaurce Typa i by DS E
* lg¢ Pasourcm Dwishawe Vesdor: ki
o el Figiraacar.

L]
Cuimscrcs CIEENMAME ©  com reyegEsc dacd optonad ysgDes Soaroe

T

5 Specify the Pool Settings.

The values are entered, by default.

6 Specify the Connection Validation.

The values are entered, by default.

7  Specify the Transaction Isolation settings.

The values are entered, by default.

8 Addtherequired propertiesin the Additional Properties table, such as database name (URL),
user name, and password. Enter the following.

a. databaseName
b. password

¢. portNumber
d. serverName

e. user
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Setting Up Database Access

Before You Begin

hersre  Domeroren]  Seren sosber

Sun [ava™ System Application Server Admin Console

fm P

E Secemion Sove
= BB fopkcma
2\’\"'!5-0-‘1-‘01
- - z
"Em bt p e [ camrwrized
Al it w ek I Tt b TS auminiii: Mg
[
= @ moune
-.._':mhunl

T Tt Fuol e tinids || Ersbiud

T RAC L ISk

Click Finish.

To Create a JDBC Resource

Applications get a database connection from a connection pool by looking up a data source on
the Java Naming and Directory Interface (JNDI) tree and then request a connection. The
connection pool associated with the datasource provides the connection to the application.

Before creating a JDBC resource, first create a JDBC connection pool. See “To Create a JDBC
Connection Pool” on page 20.

Expand the Resources, then JDBC path node.
Select the JDBC Resources node.

Click New from the JDBC Resources page.
Specify the Resource settings as follows:

a. JNDIName: Specify a unique name.

The JNDI name organizes and locates components within a distributed computing
environment similarly to the way that card catalogs organize and represent locations of
books in a library. Consequently, the JNDI name becomes an important method of
accessing the JDBC resource. By convention, the name begins with the jdbc/string.
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For example: jdbc/payrolldb.

Note - Remember to give a forward slash.

b. Pool Name: Choose the connection pool to be associated with the new JDBC resource.
c. Description: Type a short description of the resource.

d. Status: If you want the resource to be unavailable, deselect the Enabled checkbox. By
default, the resource is available (enabled) as soon as it is created.

5 Click OK.
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Creating aWSDL Document For Type : DATABASE

In this section, you add a WSDL document, to the BPEL Module project and then use the
Partner view of the WSDL editor to configure the components of the WSDL document.
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To Create aWSDL Document : dbWSDL

Expand the project node in the Projects window.
The New WSDL Document wizard appears.

Right-click the project node or Process Files node. Select New —> WSDL Document.

() BpelModuleSample - NetBeans IDE 6.1 =Jo&3

File Edit View MNavigate Source Refactor Buld Run Profie  Versioning Tools Window Help

80 f‘.-"'-'.-':_LH“c‘EI - @ -

| Projects 4 x Files (Services
= 5 BpelModuleSample -
| Process Files
— 3 Fteferentedl-‘-; M ¥ [T ePEL Process...,
Lacal History hE Eﬂmmﬂ.m '
Fnd..  CuWF | P Other... Ay
Tools ]

In the File Name field, enter dbWSDL.wsdl.

Select Concrete WSDL Document.
= binding

Defines the message format and protocol details for a port type. For JDBC Binding
Component, this is always a message containing a database operation defined using the
JDBC APL

= gervice

Indicates which binding to use and how to access the database resource. For Database
Binding Component, the address element (<jdbc:address>) specifies the JNDI name for the
database resource.

In the Binding field, select Database from the drop-down list.

Choose any one of the following Types from the drop-down list.

= Table
= Prepared Statements
= Procedures
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26

7

9

=  SQLFile

Choose Type — Table from the drop-down list.

m

Steps

1. Chooss File Type

2. Wame and Location

3. Salect one of the Foliowing :

4. Select DataSounce and Table
Obijects

5. Select Operation Specific
Aktributes

6. Enter JJDT Name

Mame and Location

Fie Neme: | dbWSDL |

Project: BpelModueSample

Crested e  DifDatsheciepehockiesancelrci S wed i

Targek Hasaspace | nep:)fee retbeans crgjwecEpeMod.desanple/ ot |

WEDL Type: () Bbstract WSDL Document

(%) Conerete WSDL Document
Binding: oatamasE v
Type: Table (o]

Click Next.

Select the URL from the drop-down list.

Steps

Select one of the Following :

1. Choose File Type

Z. Mame and Location

3. Select one of the
Following :

Objects

Attributes
6. Enter JNDI Mame

4. Select DataSource and Table

5. Select Operation Specific

URL:  <Select an Item from the list>

T ———T
jdbc: derby: ) flocalhost: 1527 ftravel [travel on TRAVEL
lidbc: desby:  flocalbost: 1527 fvir [vir on VIR]
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You find the MySQL Database is not configured and is not available in the list.

Note — A broken icon indicates that the database is not connected.

File

FEES XHEDE TE IPB-@-

Projects :Files

m i:ffnewl:u 40 =

=8 Databases
| —[§ JavaDB

®-0 Drivers

i [l idbe:derby: fflocatbast: 1527 vir [vir on WIR]
+-40 web Services
# @ Erterprise Beans (2.x)
= i servers
LT GassFish V2

€| I

50 iobesderby:fflocabosts 527 travel[ravel on TRAY

v To Select the Database Connection
See “To Create a WSDL Document : dbWSDL’ on page 25 to Create the WSDL Document.

Before You Begin

1

2

Select the URL from the drop-down list.

Selach one al th following :

St
1. Choose Fie Type =
Z, Maie and Location LAL <Selact an Jtem From the kst E
# f""‘t"":“m Zekect en ltem from the ks>
4, Selnct DakaSe res and Table sdbooderby: [ locakhost= 1527 Jsample [app on APP]
sl der by flocabhost: 1527 iravel [travel on TRAVEL]
8. Sslect Operabion Spacfic

pbooderby fflocabhost: 1527 fur [vir on VIR]

Click Next.
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28

Select the table from the DataSource and Table Objects.

Click the right arrow to move the table from Available Tables to Selected Tables.
Click the left arrow to remove the table from the list of Selected Tables.

Note - You can select and move one table at a time.

Click Next.

Select Operation Specific Attributes.

T Meow WSDL Document
Shipes Sebect Oyeeration Specilic Altributes
1. Chooss Fbe Type —_— — -
2, Mame and Location Sserck T ks s Propeties
3, Select ore o the bollowieng © custeaner [ B anred. il
4, Selact DataSounce and Tabls | D@
Ohjects
5. Sslect Operation Speofic
Attributes
6. Enber INOL Mame
|
[t ][ et ] [ree ]

Click Advanced. Select the required Column name.
You can Insert, Update, Find, and Poll Records.

Note - As the ID is unique, they cannot be unchecked. Hence, these are greyed out.
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!

Insert | Update ||m:|-|| Poll Recards |
Select Column name
phone
addresslinel
credit_limik

eligenipe. crinl=
addresslinez
email

skate

2y

oL ot e

Fam
narne
Ciky

EREEREREEFREEEE

[ Select Al H Clear Al ][ (8] 4 ][ Cancel

Note - Based on the requirement, you can check and deselect the Column names.

a. Choose Select All to select all the Column names.
b. Choose Clear All to clear all the Column names.
8 ClickOK.
9 Click Next.
10 Enteran appropriate JNDI Resource Name.

11 Click Finish.

Using the Database Binding Component 29



Creating a WSDL Document For Type : DATABASE

30

Observe the following:

= Inthe Projects window, the IDE adds a dbWSDL.wsdl node under the Process Files node

along with the .xsd file.
= The dbWSDL.wsdl file is open in the WSDL editor.

The WSDL editor has three views: Source, WSDL, and Partner.

= The Properties window is open.

Note - If you do not see the Properties window, choose Window —> Properties.

= The Navigator window is open.

To Edit the SQL Code

Double-click the created WSDL Document, dbWSDL.wsdl.
The WSDL Editor is opened.

Expand Bindings —> binding PortType="jdbcPortype”.

For instance, you want to perform a find operation.

Select and expand find from the list.
Expand inputFind and click jdbc:input.
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4 Selectsql from Properties.
Modify the SQL Statement.

5 Clickthe ellipsis.
The jdbc:input — sql Editor appears.
Make the necessary changes.

For example:
select PHONE, STATE, NAME, ZIP, ADDRESSLINE1, ADDRESSLINE2, CREDIT_LIMIT,

EMAIL, CUSTOMER ID, CITY, FAX, DISCOUNT_CODE

from CUSTOMER where NAME=? and CUSTOMER ID=?

e jdbc:input - sgl .

seleck

PHOME,STATE,NAME, ZIP, ADDRESSLIME L, ADDRESSLINEZ, CREDIT_LIMIT,EMAIL,
CUSTOMER_ID, CITY,FAX, DISCOUNT _CODE From CUSTOMER where NAME=?
and CUSTOMER_ID=?

Ik ] [ Cancel

6 ClickOK.
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7  Clickthe paramOrder from Properties and enter the values.
For example, you want to find for NAME and CUSTOMER_ID. Enter the parameter order of

the result.
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SeeAlso WSDL View

= Inthe WSDL view of the WSDL Editor, the WSDL file appears as a tree component or a
series of columns.

m  The WSDL view has two subviews: tree view and column view. To switch between the
subviews, use the buttons in the WSDL Editor toolbar.

= The main nodes in the WSDL view correspond to the major elements in a WSDL file.
= Types: This node enables you to import XML schemas and to add inline schemas.
= Imports: This node enables you to import WSDL files.
= Messages: This node enables you to create, edit, and delete messages.
= Port Types: This node enables you to create, edit, and delete port types.
= Bindings: This node enables you to create, edit, and delete bindings.
= Services: This node enables you to create, edit, and delete services.
= Extensibility Elements: This node enables you to add the following extensibility
elements: partner link types, properties, and property aliases.
Some of the nodes in the WSDL view allow you to add extension attributes.

Right-click the node and choose Add Extension Attribute.

Specify the name and namespace in the Add Extension Attribute dialog box.
Specify the value from the Properties window after adding the attribute.
Right-click the node and choose Remove Attributes to delete the attribute.
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= Right-click a node and choose Go To —> Source.

The Source view appears with the cursor positioned at the beginning of the component's block.

SourceView

In the Source view, the underlying XML source code appears. You can directly edit the XML.

1. The top of the Source Editor has a tab for each open document. Each tab shows the name of
the document.

Note - If the document has been modified and has not been saved, then an asterisk (*)
appears after the name. You can right-click a tab to access various commands.

2. Atoolbar islocated at the top of the Source Editor window.
3. Source code displayed in the Source Editor is syntactically colored.

4. The Source Editor status line is located beneath the horizontal scroll bar. To toggle between
insert mode and overwrite mode, use the Insert key.
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Creating a WSDL Document For Type SOAP

In this section, you add a WSDL document to the BPEL Module project. Later, you can use the
Partner view of the WSDL editor to configure the components of the WSDL document.

When creating or editing a WSDL file, you may be prompted to select a binding type and a
binding subtype. A binding contains protocol and data format information for the operations
and messages of a port type. For more information, see step 6.

To Create aWSDL Document : SOAPWSDL

1 Expand the project node in the Projects window.
The New WSDL Document wizard appears.

2 Right-click the node or Process Files node. Choose New —>WSDL Document.
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In the File Name field, enter SOAPWSDL.wsdlI.

Select Concrete WSDL Document.

binding
Defines the message format and protocol details for a port type. For JDBC Binding

Component, this is always a message containing a database operation defined using the
JDBC APL

service

Indicates which binding to use and how to access the database resource. For Database
Binding Component, the address element (<jdbc:address>) specifies the JNDI name for the
database resource.

In the Binding field, select SOAP from the drop-down list.
The Binding — SOAP is selected and displayed, by default.

Select any one of the following Type.

If you select the SOAP binding type, then you must select any one of the following binding
subtypes:

RPC Literal: The operations are RPC oriented (that is, messages contain parameters and
return values). Each message part references a concrete schema definition by using the
element or type attribute.

Document Literal: The operations are document oriented (that is, messages contain one or
more documents). Each message part references a concrete schema definition by using the
element or type attribute.

RPC Encoded: The operations are RPC oriented (that is, messages contain parameters and
return values). Each message part references an abstract type by using the type attribute.
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7 ChooseType — RPC Literal from the drop-down list.

€ New WSDL Document &4
Steps Mame and Location
Chaess File Type Fiie Mame: SOAPWSEDL

1

2. Mame and Location
3. Abstract Configuration
'

Project: BoetodukeSample
Foders e

Created Fle:  DviDatabass|BpalModulaSamplsisrc) SOAPWSDL, wedl

Conoreta Configur ation

Target Mamespace: hitp:[[j2ee. netheans, org/wsdlBpaiModuleSample [ SOAPWSDL

WEDL Typa: i) Abstract WSDL Document

oy [sow ]

Type: RPC Liveral [+]
[ <Bacc J[ met> ] roon [ cancl |[ e ]

8 Click Next.
This action displays the New WSDL Document dialog box.

9 Choose the Operation Type from the drop-down list.
The WSDL Editor is used to create, edit, and delete port types.

The WSDL Editor supports the following categories of operations:

= Request-Response Operation: The operation receives a message as input, and sends a
message as output.

= One-Way Operation: The operation can either receive or send a message as input.

Each message contains one or more logical parts. Specify the name and the type of content for
each part.
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Tip - If you change the name of a port type or operation, then the WSDL Editor renames all
occurrences in the same file.

a. Right-click the component node to rename all occurrences in associated XSD, WSDL, and
BPEL files.

b. Choose Refactor —> Rename.

When Operation Type : One-Way Operation. The illustration is as shown.

'ti Hew WSDL Document ﬁ
Steps Abstract Configur ation
1. Choose Fi Type Port Type Mame: | SCAPWSDLPortType
2. Mame and Location
3. Abstract Configuration Cperation Mame:  SOSPYWSDLOperation
4. Concrabe Configuration -
Operation Type: | QNe-Way Operation W
Trput: Message Part Name Element Or Type
partl sd:string [l

Generabe partnerinktype aubomatically,

[ <Back |[ mewtz | [ concel || Hew |

Note -
Click the ellipsis to select any Element or Type.

b. Enter both the Input and Output Message Part Names for Request-Response Operation.
The default value of the Input and Output Message Part Names is xsd:string.

c. Click Add to another Message Part Name as the Input.
The checkbox Generate partnerlinktype automatically is selected, by default.
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Note - Click Remove to delete the Message Part Name as the Input.

See Steps 11 through 15.

10 Select Operation Type : Request-Response from the drop-down list.

Note - Port Type Name and Operation Name are populated from the previous wizard.

11 Click the ellipsis to select the Element or Type.

Ourtpet: Massage Part Mame

partd

[ Hew WSDL Document | %

Steps Abstract Configuration

L. Choose Fie Type Pork Typs Mame:  SOAPWSDLPorTyps

2. Mame and Location =

3. Ahstract Configar Oiparation Name:  SOAPWSDLOperation

4. Concrete Configuration Operation Type:  Aequest-Resporge Dperation E‘
Input: | Mzssage Part bame Elemert Or Type |

e s &

Blamert Or Typa

Fault: | Massage Part Mame

[#] Garwer ste partrerinktype sutomatically,

Element Or Type

The Select Element or Type dialog box is displayed.

12 Expand By File.
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13 Selectthe Complex Types for both the Input and Output Message Part Name.
For example, CUSTOMER.

!

'(J Select Element Or Type <}

=2 By File

E}ﬁ EpeModuleSampls

S-fel sre/CUSTOMER. xsd

E}@ Complex Types
@ Elements
@ Simpls Types

EEI---@ Built-In Schema Types

Using the Database Binding Component 39



Creating a WSDL Document For Type SOAP

14 Click OK.
The New WSDL Document is populated with the Input and Output Element Part Names.

M

Steps Abstract Configuration

1. choose Fle Type Port: Type Name: | SOAPWSDLPart Type |
2. Name and Location o [
3. Abstract Configuration S Sheeatioo NS |
4. Conerate Canfigursticn Dperation Type: |RM-RM'3P~"“" ]

Input: Magzage Flart Name Blamant Or Type

Cutpuk: Message Part Name Elemant Or Tvpe

Fauk: Mlzsgage Part Nama Elemant Or Tvpe

PL_IJTJ‘

[] Generate partnerinktype automatically.

e Cn) | o o) e

15  Click Next.
Verify the Concrete Configuration.
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16 Click Finish.

File Edk View Mavigate Source Refactor Buld Run Profile  Wersioning Tooks Window Help

FEGS XHhEDETHEIPR-G-

‘Proj.. 40 = Files | services | (B sonewsoLwsdl = - L IER
g re—— o T
LBl cusTOMER.asd E_':.: yped
| - 3
: mﬂm & i hitp:/li2ee netbeans crglwsd|BpeModuleSample [ SOAPWSDL
- 2 ports
@ Referenced Resources =&

# E SOAPWSDLOperabionk equest:
# E S0APWSIDLOperationR espanse
& C3 Port Types
# @F SOAPWSDLPOrtType
= 3 Gndngs
i3k SOAPWSDLBINdINg PortType="SOAPWSDLRort Type
= I Serwces
w @ soaPwsDLSarvica
= I Extenshilty Elements

@ [T sospwsoL

Creating a BPEL Process

In this section, you add a BPEL process file, for example, BPELProcess.bpel. Add a partner link
and three activities to the BPEL process file.
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v To Create a BPEL Process

1 Expand the BPEL Module project node in the Projects window.

2 Right-click the BPEL Module project name or Process Files node. Choose New —> BPEL Process.

] BpelModuleSample - MetBeans IDE 6.

Fle Edt View Nawigate Source Refactor Buld Run Profle Versioning Tools Window Help
PMEAES XEDETE IPBR-O-
| Services

E-IC3 Process Files
(i@ cusTOMER.xs
i[5 SDAPWSDL.we B
ﬁ dbWSOL.wedl Clean and Buld
: Referanced Resou Claan
Populste Catalog
Sat as Main Project
pan Regurad Projects
Close
Rename. ..
Move, .,
Copy..
Delate Delete
Find... Chrl+F
Proparties

This opens the New BPEL Process wizard.

3 IntheFile Name field, enter BPELProcess.
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4  Click Finish.

Fis Ed Vew MHiwigite Sorcs Refecier Buld Bon Peolls Vedosn) Took Wiedow Help
FEAS XA TEIE-O- __
Prowets @ = iservaces | lompommbes o] 4 IEIE] rakeete B n
}:Eé.w-hﬂ-l-hwh Sorer | Deuy | Mo Lsgong |11 [ | | [ || /5 e Sermice -
o 3 Proceis Al — e e e e (D Cimewe (= Repty
ey e b [
4 o — [T ? Eﬁm e
i Wi el i
= @ EI\I-il.'f\crlocuﬂ Resounes G 3 wae: ) Pwem
P St G pathen @
{5} Conp @io
& Stroctired Acbreilies
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O e o v
Note -
= In the Projects window, the IDE adds a BPELProcess.bpel node under the Process Files
node.
= The BPELProcess.bpel file is open in the BPEL Designer.
= The Properties window is open.
= Ifyoudo not see the Properties window, choose Window —> Properties.
= The Navigator window is open showing the BPEL Logical View of the BPEL Process
document.
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3

44

To Add a Partner Link

Select the Partner Link from the Projects tab (for example, SOAPWSDL.wsdl).
This is the Input WSDL.

Drag and drop the SOAP WSDL Document to the left panel of the design area.

Select the Partner Link (dbWSDL.wsdl) from the Projects tab.
This is the Output WSDL.
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Creating a BPEL Process

4 Draganddrop the database WSDL Document (dbWSDL.wsdl) to the right panel of the design

area.
O & e K] -;'_I.n.
He Bl vew Mavgets Saare efety Buld Mm Bolle vamows) Tasth  wndom el ._
o e ™ i or T . - s
S S E TE .

Prajectn @ ® | Services [E[T——r [ -EllE,_p.-uu T
i--:_.lp-u.q.um T pp— T p _Ii:i_:_.”“”w‘...:.-.h-n > -~
= ) Procua Pim - == _= Inedk {5 Fomren

] [ wevrescen bod ey e ™| Pz Link
afl CusTOMER wed
! 0 sowrwms md LA L il e
£ e el e .
B Alerawsd bopares By
Cpuimt
3 b Mo
() aeTwan
. -
@ = Partmerlink? [Partre Link]-— B =
[ = ke - =
Sroparty Lo [
= agrre fwinwins ]
AL Pl [
Fartnar Lew Typn t =]
= LT (=]
e L] [Pl Lisk ) 1]
A gt Tl T e e, - I~ & = --;_-z" A AT B,y - il el

v To Add aWeb Service and Basic Activities

Drag and Drop the following Web Services:

= Receive
= Invoke
= Reply

Drag and Drop the Basic Activities : Assignl and Assign2.

1 Selectthe Web Service : Receive in the Web Service section of the Palette.
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2 Dragtheselection to the BPELProcess box in the design area between the Process Start and the
Process End activities.

The IDE provides the visual clues to show an appropriate location to drop the selection.
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This action places a Web Service Receive called Receivel in the Design view.

3 Select the Basic Activities — Assign in the Basic Activities section of the Palette.

This action places a Assign activity called Assignl in the Design view.

4 Dragtheselection to the BPELProcess box in the design area, between the Process Start and the
Process End activities.

Note - Repeat steps 1 through 4 to select Invokel, Assign2, and Replyl.

Choose the following:

= Select the Web Service : Invoke and Basic Activities : Assign.
= Select the Web Service ; Reply.
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Note - In the diagram, a red cross next to an element means that the element has not passed
validation and the output contains errors. Edit each Sequence to pass validation.
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The icon symbolizes that the Web Services can be edited.
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v To EditWeb Service : Receivel

1 ClickWeb Service — Receive1 and click Edit.
This opens the Receivel [Receive] - Property Editor.

2 Select the properties from the Main tab. Select PartnerLink1 from the drop-down list.
The IDE fills in the Operation field with SOAPWSDLOperation.

.
fﬁnmh-ﬂ [Receive] - Property Editor X
Man Cu:urrelaﬁﬁrs|
e Receivel
Partnier Link:  PartnerLinkl :]
Operation: ESOAPWSDtOparm E]
Input Yariable: |Bmwsa |
Create Instance

Ok ” Canicel ]l Help l}l

3 Createanew inputvariable.
Perform the following:
= (Click the Create button next to the Input Variable field.
This opens the New Input Variable dialog box.
= The Name, Type, and Scope are displayed, by default.
You can also change the value in the Name field.

= Click OK.
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|

Mame: | SOAPWSDLOperationln |

Type: | uleSample{SOAPWSDL: SOAPWSDLOper ationRequest |

SCope: | :

Note - All the fields are populated with the assigned values.

Input Variable — SOAPWSDLOperationIn

Name: FRecsivel |
Partner Link: | Partnerinkl el
Operation: | SOAPWSDLOperation v
Input Variable: SOAPWSDLOperationIn | [Create ... [Browse ...
[¥] Create Instance

Lok J[ concel J[ heb ]

4 Click OK to close the Receive1 [Receive] - Property Editor.
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5 Click SaveAll.
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v To Edit the Web Service : Invoke1
1 Click Web Service — Invoke1 and click Edit.
This opens the Invokel [Invoke] - Property Editor.
2 Select the properties from the Main tab. Select PartnerLink2 from the drop-down list.
Select any one of the Operations from the drop-down list.
= [nsert
= Update
= Delete
= Find
= Pollrecords
51
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Select Operation — find from the drop-down list. The IDE fills in the Operation field.

Partrner Link; -Partnu'Lth El

Operston:  fnd |~
Input Variable:
Output Yariable: |Bm.use |

ok J[ cancel |[ tep |

3 Follow the steps to create a new input and an output variable.

a. Click the Create button next to the Input Variable field.
This opens the New Input Variable dialog box.

Mame: | FindIn|

Type: |http:,l',l'jZee.netl:ueans.u:urg,l'wsdl,l'deSDL:inputMsg

|
|
Scope! | EPELProcess

i ik, i | Cancel J
"

The Name, Type, and Scope are displayed, by default.

You can also change the value in the Name field.

b. Click OK to close the New Input Variable dialog box.
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¢. Click the Create button next to the Output Variable field.
This opens the New Output Variable dialog box.

U New Output Variable

Mame: Fincitﬁut

Type: | http:jfizee.netbeans, orgfwsdlfdbbSOL: oukpukisg

Scope: ! BPELProcess | vl

Ok ][ Cancel ]

The Name, Type, and Scope are displayed, by default.

You can also change the value in the Name field.

d. Click OK to close the New Output Variable dialog box.

Note — All the fields are populated with the assigned values.

Select the following Variables:

= Input Variable : FindIn
= Qutput Variable : FindOut
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54

4 Click OKto close the Invoke1 [Invoke] - Property Editor.

5 Savethe project.
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To Edit the Web Service : Reply1

Click Web Service : Reply1. Click Edit.
This opens the Replyl [Reply] - Property Editor.

Select the properties from the Main tab. Select PartnerLink1 from the drop-down list.
The IDE fills in the Operation field with SOAPWSDLOperation.

Operation: | SOAPWSDLOperation [

(%) Mormal Response

Output Varisble: | | Browse ..,
() Faulk Response

Fault Name | | NO0SE |,

Fault Varialle | | Create ... | [Browse

Follow the steps to create a New Output Variable.

a. Make sure to select the Normal Response radio button.
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b. Click the Create button next to the Output Variable field.
This opens the New Output Variable dialog box.

>

Name: | SOAPWSDLOperationOut |

Type: |J[eﬂampIeJSDAPWSDL:SDﬁPWSDLDp&atiurﬂespnnse|

Scope: | BPELProcess

S

Ol ” Cancel J

c. Change the value in the Name field. This is optional.
Replyl is displayed, by default.

d. Click OK.

hame: Reply1
Partner Link: | Partnertinkl ™
Operation: |SOAPWSDLOperation ™
(%) Normal Response
Output Variable: | SOAPWSDLOperationOLt |
() Fault Response
Fault Name; | | [Choose ..
Fault Variable: | | [Create ... | [Browse

Lok [ Cancel J| reb |
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4 Click OK to close the Reply1 [Reply] - Property Editor.
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To Edit the Basic Activities : Assign1

1 Double-click the Basic Activity : Assign1.
This displays the BPEL Mapper window.
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2 Expandthe node in the Source tree pane (the left pane) of the BPEL Mapper under Output —>
Variables (for example, SOAPWSDLOperationin).

A partl node appears under the SOAPWSDLOperationIn node.

Expand the node in the Destination tree pane (the right pane) of the BPEL Mapper under Input

For example, SOAPWSDLOperationIn — partl — CUSTOMER_Record.

3

—> Variables (for example, FindIn).

A part node appears under the FindIn node.
4 Selectthe nodein the Source tree pane.
5

For example, FindIn — part — CUSTOMER_Record.

Using the Database Binding Component

Drag the selection and map it to the node in the Destination tree pane.
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6

58

Map the following Variables:

a. NAME —NAME

b. CUSTOMER_ID — CUSTOMER_ID
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Click the Design tab.

Note - A red icon marked against Basic Activities — Assign1 is not shown.
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To Edit the Basic Activities : Assign2

Double-click the Basic Activity : Assign2.

This displays the BPEL Mapper window.

Expand the node in the Source tree pane (the left pane) of the BPEL Mapper under Qutput —
Variables (for example, FindOut).

Expand the node in the Destination tree pane (the right pane) of the BPEL Mapper under Input
— Variables (for example, SOAPWSDLOpertionOut).

Select the node in the Source tree pane.
For example, FindOut : part : CUSTOMER_Record.

Drag the selection to the node in the Destination tree pane.
For example, SOAPWSDLOpertionOut : partl : CUSTOMER_Record

Map the following variables:

PHONE : PHONE
STATE : STATE
NAME : NAME
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60

= ZIP:ZIP

= ADDRESSLINE1 — ADDRESSLINE1

= ADDRESSLINE2 — ADDRESSLINE2

= CREDIT_LIMIT — CREDIT_LIMIT

= EMAIL — EMAIL

= CUSTOMER_ID — CUSTOMER_ID

= CITY —CITY

= FAX —FAX

= DISCOUNT_CODE — DISCOUNT_CODE

Finally, map part: partl.
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6

Click the Design tab.

The final output is as shown in the illustration.
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Right-click the project node and select Clean and Build.
The following message is displayed.
BUILD SUCCESSFUL (total time: 2 seconds).

Click Save All.

Validating BPEL

The BPEL Designer has a built-in BPEL code validation functionality that helps create

well-formed, valid and standard-compliant code. The code is checked for errors and is notified

if validation fails.

To Invoke Explicit Validation

To invoke explicit validation, perform any one of the following:

Right-click the source to invoke the pop-up menu in the Source view and choose Validate XML

(Alt-Shift-F9).

Using the Database Binding Component
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Design View : Notifications

Click the Validate XML button (Alt-Shift-F9) on the Editor toolbar in the Design view.

Design View : Notifications

62

The user is notified about validation errors or success in the Output window, in the Design
view, and in the Navigator.

The Design View

The Design view shows the results of both real-time and explicit validation in call-out windows
on the diagram and the error stripe.

In the illustration,

Note - A red cross next to an element on the diagram means that the element has not passed
validation and the output contains errors.

A yellow triangle with an exclamation mark means that the element has not passed validation
and the output contains warnings.

A red cross in the Design view means there are both errors and warnings.

If you click the cross or the triangle, a call-out window appears with a list of errors and/or
warnings.
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The call-out window includes messages related to validation in accordance with all the criteria
listed above. Messages related to the real-time validation are constantly updated.

In the Design view, validation results are also shown by the error stripe, which is a strip to the
right of the scroll bar that contains red marks if some elements have not passed validation. The
error stripe represents the entire diagram, not just the portion that is currently displayed. You
can immediately see if the BPEL process contains errors without having to scroll through the
entire diagram. You can click a red mark to jump to the element that causes problems. If no
errors are detected, the small square in the error stripe is green.
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Creating the Composite Application Project

Add the JBI module to the BPEL Module project before deploying the Composite Application.
Deploying the project makes the service assembly available to the application server, thus
allowing its service units to run.

v To Create the Composite Application Project

1 Choose File —> New Project from the main menu.

This opens the New Project wizard.
2 Selectthe SOA node from the Categories list.

3 Selectthe Composite Application node from the Projects list.
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4 Click Next.

5
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66

6

7

Click Finish.

The Projects window now contains a project node for a Composite Application project called
DBBCSampleComposite App.
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Right-click either the Composite Application Project node or expand the node and select JBI
Modules.
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8 Select Add JBI Module.
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9 Select the BpelModuleSample Project. Click Add Project JAR Files.
The Project JAR Files is build/SEDeployment.jar.

c

Lockin: || Database wl 3 9
o 1B

E DEBCSampleCompositespp | BpelModulesample

Project Mame:

Project JAR Files:

build/SECeployment. jar

File: marne: | 0:\Database) BpeMaduleSannple | [ Add Project JAR Files ]

Files of type:  Project Folder | Cancel |

The BpelModuleSample.jar file is added into the project.
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10 Click SaveAll.
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A detailed illustration is as shown on the deployed JBI Components.

a. Expand IDE, open the Services window, expand the GlassFish V2 node, and expand the JBI
node.

b. Right-click sun-database-binding and click Start.
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Note - If you do not see the JBI node, you need to start the Application Server by choosing
Start from the pop-up menu of the GlassFish V2 node.

J -

AR XEDE TH B O
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[

& webServices

@ Entarprise Baans (2.x)

=2 Servers

S5 GlassFich V2

3
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11 Right-click the DBBCSampleCompositeApp Composite Application project node and select

Clean and Build.
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Test BEWFE
Debug [BPEL)
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L check | JavaD@Databy  Foeme e ey
ML walidation startad. e I
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The CASA Editor displays the build of DBBCSampleComposite App.

SRR SameComprta et 0 4 SEX]
Fia Edt Wew Novgels Sounte Refactsr Buld fun Profle Versorg Tookh  Wandom  Help
FEHES XD TE - @ - ,
Frojects o = SErvices mmmm 5.5 Rl Al 3@
S-I5 Randdmng sores |Deson | ) T B W

= [ DnBCSsmplel ompasite Ay =
Taruics Agyersthy WEDL Port Bl Madule

L nE:,Li!I
E.E
Ey'x
¥
]

SDAP

. DATABA.,

=TT —
[ perurracess
e Parneiink)

AY 2 AY

Parnarlink? 3 dud

-
4| *

RUTE O =
[ |30 chick » | duwa 08 Databane Frocess » | Glasstish vz s | bkl ol b »

[ | Patlding jac: Do Daksbass DEBCSaplefiepositadpp’ dive’ DEECTanpleCoponttalpp. ip
jEi-clean-build
EUILD SUCCESSFUL (tocal time: T wecomdui|

L )

|

A message is displayed in the Output window:
BUILD SUCCESSFUL (total time: 2 seconds)

12 Click SaveAll.

Deploying and Testing the Composite Application

In this section, you deploy the Composite Application project and then test the deployed
application. Start the GlassFish Application Server before deploying the project. See “Starting
the GlassFish V2 Application Server” on page 10.

v To Deploy the Composite Application
Troubleshooting
= Stop the GlassFish V2 Application Server and Restart to ensure the connection.
= Logout of the GlassFish Admin Console and Login.

®  Goto Resources —> JDBC —> Connection Pools —> Choose the defined Connection Pool.
®  Click the Connection Pool.
The Edit Connection Pool screen is displayed.
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2

= Pingthe Connection Pool.
The following confirmation message appears.

Ping Successful

Sun java” System Application Server Admin Console

Select the project node in the Projects window.
For example, DBBCSampleCompositeApp

Right-click and choose Deploy.
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74

After successful deployment of the project the following message appears in the Output

window:

BUILD SUCCESSFUL (total time: 18 seconds)

To Test the Composite Application

Click Test.

Right-click and select New Test Case.
Enter the Test Case Name.

Click Next.

Select the WSDL Document.

a. Select the following:

For example, SOAPWSDL.wsdl from BpelModuleSample : Process Files.

Note - One WSDL document must be selected.

[ New Test Case

Steps

Select the WSDL Document

1. Erter the Test Case Name

2. Select the WSDL
Document

3, Select the Operstion ko Test

W3DL Documents:

B DBBCSampleComposkedpp - Process Flles
=) BpeModuleSamphe - Process Files

LS dbwsDL.wsdl

£

Selected WSDL: D:'Databasi'ﬂ:dﬂudulaEarrpb‘l,srdEDM‘u‘EDL.ws-

| < Back H Mext = ]

b. Click Next.
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Deploying and Testing the Composite Application

¢. Select the following:
SOAPWSDLOperation from SOAPWSDLPort (Binding="SOAPWSDLBinding”)

Note - One operation to text must be selected.

#~

© Wew Test Case &

Steps Select the Operation to Test

1. Enter the Test Case Name Binding Cperations;

2. Select the WSDL Documert

3. Select the Operationto | SOAPWSDLPor (Bindng="S0APWSDABndng')
Test

Selected Operation: | SOAPWSTAOperation SOMPWSTLOperationRequest): void

] |
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6  Click Finish.
The Source Code is as shown.
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7  Enterthe string values.

For example:

NAME — Nano Apple
CUSTOMER_ID — 3
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When you enter the string values in the Input.xml window, the output console displays
Retrieve.xml. This window displays the location to save the data.

Right-click the Test Case and cl

A confirmation box to overwrite the Output is displayed. Click Yes to overwrite.

m

ick Run.

.\p The expacted output: file for the test case i empty, Do vou want to save the most recant output 35
the tesk case’s expectad output file For comparison during later test runs?
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The Output is as shown in the illustration.
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Debug the Test Case

You can debug the test case.
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V¥V ToDebug theTest Case

® Right-click on the Test Case and select Debug.

A message is displayed as shown in the illustration.
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For a demonstration, see
http://wiki.open-esb.java.net/Wiki. jsp?page=DatabaseBindingComponentFlightDetails.

Creating a BPEL Module Process Using Prepared Statements

A Prepared Statement represents a SQL statement that has been compiled. Prepared statements
can be used to perform insert, update, delete and query operations. Prepared statements
provide the ability to create queries that are more secure, have better performance, and are
more convenient to write. They come in two flavors: bound parameter prepared statements,
and bound result prepared statements.

Prepared statements allow query templates to be created and then stored on the database server.
When a query needs to be made, data to fill in the template is sent to the database server, and a
complete query is formed and then executed.

The basic process for creating and using bound parameter prepared statements is simple. A
query template is created and sent to the database server. The database server receives the query
template, validates it to ensure that it is well-formed, parses it to ensure that it is meaningful,
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and stores it in a special buffer. It then returns a special handle that can later be used to reference
the prepared statement. When a query needs to be made, data to fill in the template is sent to the
database server, and then a complete query is formed and then executed.

This process has some very important behaviors wrapped up in it. The body of the query is only
sent to the database server once. On requests to execute the query, only the data to fill in the
template needs to be delivered to the database server. Most of the work required to validate and
parse the query only needs to be done a single time, instead of each time that the query is
executed. Additionally, for queries that contain a small amount of data, the overhead of sending

the query is greatly reduced.

For steps, see the following links:

1. “Creatinga WSDL Document For Type : DATABASE” on page 24

a. Select Type — Prepared Statement.

Hame and Location

) Mew WSDL Document
Steps
1. Chooss File Type
2. mame and Location
3 Salact one of the Following :
4. Enter A Frepared Stabement
5. Enter JNDT Nama

File Mame: | dbwisD|

Prajack: BpsMadubas amplal
Folder: &

Creabed File:  D:|DatabaseiBpelodulasample sl dbWSDL. wsdl

Target Mamespace: |hitp: ||{2ee.netbeans, org)wsdlBpelodulesample 1 {dow'SDL

WEBL Type: ") bstract WSHL Document
() Cantrate WSDL Docusert

Brding: DATABAZE

Type: Prepared Statements

[coce ) [0 ]

b. Enter avalid Prepared Statement.

c. Click Discover Parameters to view types for the parameters.

d. Click Discover Resultset to discover the Resultset types.
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2
3
4.
5
6
7

For a demonstration, see

Talact ™ brom CUSTOMEE. whars CUSTOMER_De? [erer— et To
e paranl | L AT
Dsves P weshany

e. Click Next.

f. Enter JNDI Name.

g. Click Finish.

“Creating a WSDL Document For Type SOAP” on page 34.

“Creating a BPEL Process” on page 41.
“Validating BPEL” on page 61.

“Design View : Notifications” on page 62.

“Creating the Composite Application Project” on page 64.

“Deploying and Testing the Composite Application” on page 72.

http://wiki.open-esb.java.net/Wiki.jsp?page=DatabaseBindingComponentPollScenario.
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Creating a BPEL Module Project Using Procedures

82

A Procedure represents a database stored procedure. Fields correspond to the arguments of a
stored procedure while methods are the operations that you can apply. It allows you to execute a
stored procedure.

Note - Select a Procedure from the list and add the stored procedure to the Selected Stored
Procedures console.

For the procedure, see the following links:

1. “Creatinga WSDL Document For Type : DATABASE” on page 24

a. Select Type — Procedures

0 New WSDL Document =]
Steps wame and Location
1. Chooss Fie Type Fike Name: | cHWSDL
£,  Mame and Location
3 Select ane of the Follavang - £
4. Select 2 Stored Project: reparedsStshefpaModuls

Procedure/Funchon From the Fedars - Browss...
list

2
ke AL Mo Crested Fle: | DiILDWP_BCIPreparedstateapaModule s chdbWsDL. wsdl

Target Namespace: hitp:(/iZee.netbeans, arg)wsdl/PreparedStateBpeiModule/dbwSDL

WEDL Type: () Abstract WSDL Document
(#) Cancrats WIDL DocLment
Eincing: DATABASE >
Type: Procedures '4']
<Back || Mest > Concel || Helo

b. Click Next.
Select the URL from the drop-down list.

d. Select a Stored Procedure and click Add to move the selected Stored Procedure to the
Selected Stored Procedure panel.
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Crose Fie Type
Parme anc Location

Saluect e of the Fallawrsg :
Select & Skared
Procedure Fustion rom
the bt

Enter MO Mame

B

n

Girnt

e. Click Next.

f. Enter JNDI Name.

g. Click Finish.

“Creating a WSDL Document For Type SOAP” on page 34
“Creating a BPEL Process” on page 41.

“Validating BPEL” on page 61.

“Design View : Notifications” on page 62.

“Creating the Composite Application Project” on page 64.

NSk » N

“Deploying and Testing the Composite Application” on page 72.
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For a demonstration, see

http://wiki.open-esb.java.net/Wiki. jsp?page=DatabaseComponentStoredProcedure.

Creating a BPEL Module Project Using SQL File

This is the script that contains the data definition statements for the MySQL database. The file
filter for the file open dialog window defaults to *.sql so you should only be able to view files

with the .sql extension.

For procedure, see the following links:

1. “Creating a WSDL Document For Type : DATABASE” on page 24.

a. Createa.sqlfile using Notepad.

b. Save the file in a folder location.

L

select * from CUSTOMER wheére CUSTOMER_ID=?

| Save As

5%

¥ G @
]
=
L]

c. Choose Type — SQL File.
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Steps Mame and Location
L Choogs Fle Type Fibe Mame: - dbWSDL
2. mame amd Location
3 felect one of the Followng =
PraparedStalsBpaboduls
% Plesse el o SGL File Frejact |
5. Erker A Prepared Statement Folder! L] I._......_““"" ]
5. Erter JNDH Mams 5

WD, Types: () Mostract WL Decument

{7} Concrate WSDL Documert
Bnding: CATABASE ||
Tive: —

Froh | [LConcal J[ teb ]

d. Click Browse to select the saved .sql file.
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D Harw WS Doecumeentt

Steps

Choose Fie Type
Maames and Location
Ealmct o of the Followng -
Pleagse sebect a SQL Fle
Erdaf i Preparad Statsment
Ertar JuDT Mams

ok e

* ?OEE

Lookin: |~.'.pm'n'nl.m-::.-:|

Fla nama: notepad_save.sgl

Fias of bype: EMFH!-

(uGancel ]

&

(e ]

The selected file is displayed as shown in the Figure.

[Lcoc J[ o0 ]

Please sebect a SOL File

S0 ke Location :

]Er'.nmmau_uwe.sql

[ <Back |[ Mest> |

rrish | [auianceles] [t

e. Click Discover Parameters to view types for the parameters.

f. Click Discover Resultset to discover the Resultset types.
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M

[

oo Pis Type
Farea i Location

S orwof Hha Followng ¢
PMamia sele:! § 20U He
Enler A Pregared
e

=M NE

k. Bty HO{ s

e A Peepster oot
Prepaned Statement Editor
amiact * o CUSTOMER mhars CLISTOMIR_[De? [ e maree PFarareier Type
fparam1 it
-
- i —
e [awalang.Steing |
STATE avalang String =
Loz | [omee ][ 1w ]

g. Click Next.

h. Enter JNDI Name.

i. Click Finish.

“Creating a WSDL Document For Type SOAP” on page 34.

“Creating a BPEL Process” on page 41.

“Design View : Notifications” on page 62.

“Creating the Composite Application Project” on page 64.

2
3
4. “Validating BPEL” on page 61.
5
6
7

“Deploying and Testing the Composite Application” on page 72.

For a demonstration, see

http://wiki.open-esb.java.net/Wiki. jsp?page=BuildSampleProjectSQLFileDatabaseWSDL.

Using the Database Binding Component 87



88



	Oracle® Java CAPS Database Binding Component Tutorial
	Using the Database Binding Component
	Tutorial Plan
	Database Binding Component Project in a Nutshell
	Starting the GlassFish V2 Application Server
	To Start the GlassFish V2 Application Server From NetBeans IDE

	Creating a BPEL Module Project For Table Type Operations
	To Create a BPEL Module Project

	Connecting to a MySQL Database
	To Connect to a MySQL Database

	Starting the GlassFish Admin Console
	To Start the Admin Console

	Setting Up Database Access
	Integrating a JDBC Driver
	To Integrate a JDBC Driver

	Creating a JDBC Connection Pool
	To Create a JDBC Connection Pool
	To Create a JDBC Resource

	Creating a WSDL Document For Type : DATABASE
	To Create a WSDL Document : dbWSDL
	To Select the Database Connection
	To Edit the SQL Code
	Source View

	Creating a WSDL Document For Type SOAP
	To Create a WSDL Document : SOAPWSDL

	Creating a BPEL Process
	To Create a BPEL Process
	To Add a Partner Link
	To Add a Web Service and Basic Activities
	To Edit Web Service : Receive1
	To Edit the Web Service : Invoke1
	To Edit the Web Service : Reply1
	To Edit the Basic Activities : Assign1
	To Edit the Basic Activities : Assign2

	Validating BPEL
	To Invoke Explicit Validation

	Design View : Notifications
	The Design View

	Creating the Composite Application Project
	To Create the Composite Application Project

	Deploying and Testing the Composite Application
	To Deploy the Composite Application
	To Test the Composite Application
	Debug the Test Case
	To Debug the Test Case


	Creating a BPEL Module Process Using Prepared Statements
	Creating a BPEL Module Project Using Procedures
	Creating a BPEL Module Project Using SQL File


